Advanced BAIRS Reporting

This section of the manual covers the more advanced features and capabilities of Brio.Insight, the software we are using for BAIRS. This section is intended for those users who need to work with their data in more complex and sophisticated ways than the canned reports allow. It is strongly recommended that users who want to learn Brio’s capabilities, attend the BAIRS 2C class as a starting point. From there, users who want to go even further can utilize this manual, the BAIRS 2D class and drop-in office hours to master Brio’s analytical and reporting features.

Before moving on to this section, you should be familiar with the data in BAIRS and be knowledgeable about BAIRS reports and the information they provide.
Brio.Insight Interface

This section will familiarize you with the Brio.Insight components and toolbar functions. If you only run canned reports and perform functions covered in Basic BAIRS Reporting, this section is not necessary for you. If you are unfamiliar with Brio and will modify queries, format reports, and create pivots or charts, you will want to read this section.

The components you should be familiar with are labeled in the picture below. Each of these elements is further described in the following pages.
The Insight workspace is made up of three panes, the Section, Catalog, and Contents panes.

### The Section Pane

The Section Pane lists all the sections available in a Brio document. Dashboards, reports, charts, pivots, results and tables are all types of sections.

You can display sections, add new ones, duplicate them, rename them, delete them, and hide or unhide the section pane.

#### Display a Section

You must display a section to work on it. The selected section determines what displays in the Contents and Catalog panes.

1. Click on the section, i.e., query, results, etc. in the Section Pane.

   The Contents and Catalog panes change according to the section selected.
The picture below shows the Results section. The Results section in the Section Pane has a depressed box around it, indicating that it is the section currently selected. Notice the Catalog and Contents panes are different from the picture on the previous page, which shows the Query section.

**Add a New Section**

If you want to create a chart, pivot, or new report, you need to first add that section.

1. From the Insert menu, click the section you want to add.
   
   That section appears in the Section Pane.

Alternate method

1. Click on the Insert Section icon on the Standard toolbar.
   
   A list of sections drops down.
2. Click the section you want to add.

The picture below shows a new pivot section being added.

![Brio.Insight Interface](image)

Duplicate a Section

If you want to modify an existing report, for example, you should first duplicate it to have the original to compare with or in case you make a mistake and need the original.

1. Click on the section you want to duplicate in the Section pane.

2. **Macintosh and Windows**: From the Edit menu, select Duplicate Section.

   **Windows**: Right-click on the section in the Section pane and select Duplicate Section from the speed menu.

   A duplicate section is added to the section pane. This duplicate has the same name as the original, but with an incremental number added. Thus, if you duplicated a section called “Pivot,” you would have “Pivot” and “Pivot 2” in your section pane.

Rename a Section

You may want to rename a section to a name that is meaningful to you and to help you better distinguish duplicates or differentiate between “Pivot” and “Pivot 2,” for example.

1. Click on the section in the Section Pane.

2. **Macintosh and Windows**: From the Edit menu, click Rename Section.

   **Windows**: Right-click on the section in the Section pane and select Rename Section on the speed menu.
The Section Label dialog box appears.

3. Type the name you want over the label in the box.
4. Click OK.

The section now appears with the name you created.

Delete a Section

You may find that you added a section you no longer want and you want to delete it.

**Note**

You can delete any section. However, do not delete the Query or Results sections. If you delete Query, you will not be able to reprocess the report as it was intended to run. If you delete Results, you will lose all results in the report, pivot, chart, and other sections that use those results.

1. Click on the section in the Section Pane.
2. From the Edit menu, click Delete Section.

The Delete Section dialog box appears.

3. If you do not want to delete the section, click Cancel.
4. To delete the section, click Delete.

   The section no longer appears in the Section pane.

**Hide/Unhide the Section Pane**

When not in use, you can hide the Section Pane and view more of the Contents pane.

To hide the Section Pane

1. Click the x in the upper right corner of the Section Pane.

   The Section Pane disappears, and the Contents Pane expands.

To unhide the Section Pane

1. From the View menu, click Section/Catalog.

   The Section Pane reappears.

**The Contents Pane**

The Contents pane displays the section you are using. The Contents pane may show a data model, a pivot, a report, or a dashboard. It is subdivided into Document and Outliner sections. The Outliner section is not available for Query or dashboards.
The picture below shows a Pivot section. A pivot report is displayed in the Document section, and the Outliner is divided into Side Labels, Top Labels, and Facts.

**The Document Section**

The Document section displays the content of a particular section. For example, the Query section has data tables in the Document section. After a query is processed, the Results section shows raw data and the Report section displays a report in the Document section.

**The Outliner Section**

Outliners are located at the bottom of the Contents pane. They are drag and drop templates used in Table, Pivot, Chart, and Report sections. You click on items in the Catalog pane and drag them to the outliner to build the content of your pivot, chart, or report.

Outliners may be hidden, unhiden, resized, and docked using the same procedures as for Command lines. Step-by-step instructions begin on page 61.
In the previous picture, the items in the Side Labels portion of the Outliner are fund and project. Thus, the pivot report, displayed in the Document section, has a side label with fund and project codes. Outliners for particular sections are explained further in “Advanced Features of Brio.Insight” on page 66. See the section you are interested in.

The Catalog Pane

The Catalog pane appears on the left side below the Section pane. The Catalog pane displays items (e.g., fields such as org and fund), reports, and/or reporting tools. You click and drag these items to the appropriate section (e.g., outliners, command lines, etc.) and modify or build your report, pivot, or chart. Items in the Catalog change depending on the section selected. For instance, in the Query section, the Catalog displays tables. In the Pivot section, the Catalog displays request items.

The Catalog appears in a directory tree format. Click the plus sign + next to a folder name to expand the directory tree and the minus sign - to collapse the directory tree.

The Section Bar

The Section Bar lies above the Section and Contents panes. It indicates the active section, has toggle switches for outliners or command lines, and has back and forward arrows.
The picture below indicates that the active section is a pivot. The toggle switches are Sort and Outliner.

**Toggle Switches**

Click on a toggle switch to display hidden outliners or command lines or hide outliners or command lines that you do not want to view. Hiding outliners and command lines increases what is displayed in the Document Section.

**Back and Forward Arrows**

These arrows work like the Back and Forward buttons on web browsers. Click the Back Arrow to jump to the section you viewed previously. The Forward Arrow becomes active after you have clicked the Back Arrow. After you have gone backwards to look at previous sections, clicking the Forward arrow jumps you forward through the sections you have viewed.

**The Command Lines**

Command lines display below the Section Bar. Command lines offer a visual way to perform query and reporting processes. Drag items to one of the four command lines to retrieve particular data, sort it in a certain order, limit it to only certain values, or apply a data function. All lines can be hidden, resized, or docked. Command lines for particular sections are explained further in “Advanced Features of Brio.Insight” on page 66. See the section you are interested in.

Below is an example of the three command lines in the Query section.
Hide/Unhide a Command Line

1. Click the appropriate toggle switch in the Section Bar.

The command line no longer displays or else reappears, if it was hidden.

Resize a Command Line

The items in a command line may be numerous and time-consuming to scroll through. Resize the command line to see all the items and work more easily with them.

1. Double-click the vertical line along the left edge of the command line you want to resize.

The command line becomes a floating box. The picture below shows the Request Command Line as a floating box.

2. Click the bottom edge of the floating box.

Your mouse will turn into a double-arrow pointing up and down to indicate vertical resize.

3. Drag the bottom edge down until you are able to see all the items in the command line.

The floating box is now larger. The picture below shows the same Request box resized so all the items are visible.
Dock a Floating Command Line

After you are done working with a floating command line, you can redock it under the Section Bar.

1. Double-click the title bar of the floating command line.

   The line redocks.

Toolbars

Brio.Insight has three toolbars, the Standard, Formatting, and Section toolbars.

To display or hide a toolbar, select View, Toolbars, and then the toolbar name. A check by the toolbar name indicates that it is displayed.

The Standard Toolbar

The Standard Toolbar contains commonly used commands. When a section is selected, only those icons that are used in that particular section are available, the others are grayed out.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Icon" /></td>
<td><strong>Save</strong> Saves the document. Depending on options that you set, you can save documents in compressed format (recommended), save results with a document, and password protect your document on save.</td>
</tr>
<tr>
<td><img src="image" alt="Print Icon" /></td>
<td><strong>Print</strong> Prints the section you select to your local printer.</td>
</tr>
<tr>
<td>Icon</td>
<td>Definition</td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
</tr>
<tr>
<td><img src="image" alt="Print Preview" /></td>
<td><strong>Print Preview</strong>  Previews section before printing it to your local printer. This icon works as a toggle. That is, click it once to preview a section and click it again to return to normal view.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td><strong>Remove</strong>  Removes selected elements from all sections except dashboards. Use carefully as there is no message asking if you want to delete an item, and there is no undo.</td>
</tr>
<tr>
<td><img src="image" alt="Format Painter" /></td>
<td><strong>Format Painter</strong>  Copies formatting of one element to another.</td>
</tr>
<tr>
<td><img src="image" alt="Show Section/Catalog" /></td>
<td><strong>Show Section/Catalog</strong>  Displays the Section and Catalog panes if they are hidden. Hides these panes if they are displayed.</td>
</tr>
<tr>
<td><img src="image" alt="Insert New Section" /></td>
<td><strong>Insert New Section</strong>  Inserts a new section. The icon at left displays an Insert Query icon. Click the down arrow to display other types of sections to insert.</td>
</tr>
<tr>
<td><img src="image" alt="Properties" /></td>
<td><strong>Properties</strong>  Displays item properties. Available in the Query section. Select on a request item in a topic or command line and click the Properties icon.</td>
</tr>
<tr>
<td><img src="image" alt="Limit" /></td>
<td><strong>Limit</strong>  Applies limits to items in the query section or local limits to columns in the results or table sections.</td>
</tr>
<tr>
<td><img src="image" alt="Sort Ascending" /></td>
<td><strong>Sort Ascending</strong>  Sorts selected items in order of lowest to highest.</td>
</tr>
<tr>
<td><img src="image" alt="Sort Descending" /></td>
<td><strong>Sort Descending</strong>  Sorts selected items in order of highest to lowest.</td>
</tr>
<tr>
<td><img src="image" alt="Grand Total" /></td>
<td><strong>Grand Total</strong>  Applies grand totals to selected columns.</td>
</tr>
<tr>
<td><img src="image" alt="Group Labels" /></td>
<td><strong>Group Labels</strong>  Merges pivot or chart axis labels. The data associated with grouped labels is aggregated, creating a new summary label category. If labels are grouped, click icon to ungroup them and return to your original label values.</td>
</tr>
</tbody>
</table>
The Format Toolbar

The icons on the Format Toolbar work like icons on many other software programs. The formatting icons allow you to change the font type and point size; make the font bigger or smaller; make text bold, italic or underlined; left, center or right justify text; and change the line, fill, or text color.

The Section Toolbar

The Report and Chart sections have special toolbars known as Section toolbars. When you are in a Report or Chart section, from the View menu, select Toolbars and then Section to display this toolbar.
### Report Section Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Align Icon" /></td>
<td>Align  Aligns two or more selected objects to the left, center, right, top, middle, or bottom. The icon at left displays the Left Align icon. Click the down arrow for other alignments.</td>
</tr>
<tr>
<td><img src="image" alt="Make Same Size Icon" /></td>
<td>Make Same Size  Makes two or more selected objects the same width, height, or both. The icon at left displays the Same Width icon. Click the down arrow for other same size options.</td>
</tr>
<tr>
<td><img src="image" alt="Layer Icon" /></td>
<td>Layer  Sets order of a selected object. The icon at left displays a Bring to Front icon. Click it to bring the selected object to the front. Click the down arrow for other arrangements.</td>
</tr>
<tr>
<td><img src="image" alt="Set Spring Icon" /></td>
<td>Set Spring  Maintains relative vertical spacing between two selected objects. Thus, if the first object is moved, increased or diminished, the second object moves in the same flow. This icon works as a toggle. Click it again to unspring selected objects.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Icon" /></td>
<td>Zoom  Increase or decrease the report image in the Contents pane. Click the down arrow to see percentages.</td>
</tr>
</tbody>
</table>

### Chart Section Toolbar

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Chart Type Icon" /></td>
<td>Chart Type  Sets the chart type. Click down arrow to see more chart types.</td>
</tr>
<tr>
<td><img src="image" alt="Set Legend Icon" /></td>
<td>Set Legend  Sets the legend of a chart to be on the x-, y- or z-axis. Changes the chart colors accordingly.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Icon" /></td>
<td>Zoom  Increase or decrease the chart image in the Contents pane. Click the down arrow to see percentages.</td>
</tr>
</tbody>
</table>
Advanced Features of Brio.Insight

This section covers:

- working with results.
- modifying and formatting reports.
- creating pivots and charts.

These materials are not comprehensive. Brio is a powerful tool with many features and functions. Rather, the functions covered are those that are most important for BAIRS Super reports.

If you have never used Brio, read “The Query Section” and “The Results Section,” as these sections are the backbone of the others. After that, read only the sections you are interested in. Thus, if you will never create a chart, do not read that section. If you will create pivots, read that section.

BAIRS Super Reports

The reports you will use for advanced reporting have a “_Super” extension at the end of them. Thus, if you wanted to create a pivot using the Actuals to TempBudg Report, you would run the Actuals_to_TempBudg_Super report, instead of the Actuals_to_Tempbudg report.

Super reports have the following features:

- No dashboard.
  
  The dashboards interfere with the re-run capabilities of reports saved to your desktop for PC users.

- Greater ability to modify the query.
  
  For example, you can run reports for discontinuous chartfield ranges.

- PC users can re-run reports saved to your desktop.
  
  While you can use the advanced Brio features described in this section with Basic reports, you will not be able to update the data in a Basic report. To update data in a pivot, chart, or report that you create, use a “Super” report.
WARNING: The Standard Detail Super Report should only be run for continuous months to properly calculate and reflect Ending Balances.

Selecting a Report

In general, select the report with either the data you would like to see or the pre-built report section that you want to modify. Use the decision tree and report list in the Reference Appendix to help you select the right report.
The Query Section

The Query section has the three command lines, sort, request, and limit, and one or more metatopics. A metatopic is a list of items (i.e., fields such as Org Code) from one or more tables in the database. The metatopics vary depending on the report selected. Each metatopic is made up of items. These items represent categories of information, such as flexfield, PO description, or vendor ID, and are analogous to column fields in a database table.

In the picture below, the metatopics FACT_Standard_Detail_All and DIM_COA are visible. In the DIM_COA metatopic, for example, the first three items are Account Code, Account Desc, and Account Level2 Node.

Generally, the FACT metatopic contains details about the transactions, such as the PO ID or, in the case of summary reports, details about the balance. The COA metatopic contains chartfield values and their attributes, such as description and tree level. The third metatopic (not visible in the picture above) contains all other data elements.
The Query Section

Build a Query

Building a query can involve three processes: building the Request line, applying a sort, and setting limits. Each of these processes is described in detail below.

1. Build the Request Line

Placing items on the Request line instructs the database to return data for those items. The Request lines of BAIRS reports are pre-populated with items. In the picture below, the first three items on the Request line are Accounting Period, Vendor Name, and Business Unit Code.

![Request line](image)

You can accept the Request line as is or you can add or remove items.

1. To add an item, click on it in one of the metatopics and drag it to the Request line.

   The item appears on the Request line. For instructions on resizing command lines to view the items more easily, see “Resize a Command Line” on page 61.

2. To remove an item, click on it in the Request line and drag it off the line.

   If you remove an item that is used in a computation or format in the Report section, you will receive a Remove Query Column warning.

   ![Remove Query Column](image)

   • To cancel the removal, click Cancel.
   • To remove the item anyway, click Remove.

   **Note** In general, you do not want to remove items used in computations or formats of the pre-built reports.
2. Apply a Sort

This step is optional. Generally, sorting is more meaningful when applied in either the Results, Report, or Pivot sections, after the query has processed. If you need to sort at the query stage, instructions follow.

| Note | If the Results section contains a sort, that sort overrides the Query sort. |

1. If the Sort line is not visible, click Sort on the Section Bar.

2. From the Request line, drag the items you want to sort by to the Sort line.

3. Double-click a Sort item to toggle ascending and descending sort orders.

When the query is processed, the data in the Results section will be sorted accordingly.

3. Set Limits

The Limit lines of BAIRS reports are pre-populated with items. These items have limits applied to them that will restrict the data returned in the Results section. Examples of limits include data associated with only one fiscal year, data for three accounting periods, and data for a range of org codes.

Put your cursor over one of the limits and you will see what the parameters are set to for a particular item. The picture below shows that Fiscal Year is equal to 2001.

The AND buttons are operators, which are described in more detail in “Set Limits: Complex Limits” on page 79.

The “V” following some of the items on the Limit line indicate that item is a variable limit, and you will be prompted to set the limits for that item when you process the query. In the “Super” reports, accounting period and org code are set as variable limits. Instructions for setting your own variable limits are in “Set Limits: Variable Limits” on page 81.
The Query Section

Set Limits: General Steps

You can accept the limit line items as they are set, add new items to the Limit line, or change the limits of the pre-populated items. Whether you want to change an item or not, read the following steps to learn about the Limit dialog box.

1. To remove an item from the Limit line

   - *Macintosh and Windows:* Click on the item and press the Delete key.
   - *Windows:* Right-click on the item and select Remove from the speed menu.

   The item is removed from the Limit line. When you process the query, your data will no longer limit according to that item. For instance, if you removed org, the query would return all orgs that match your authority and your other criteria.

2. Select one of the following options:

   - Add an item to the Limit line by clicking on the item in one of the metatopics and dragging it to the Limit line.
   - Change the limit settings of an item on the Limit line by double-clicking on the item in the Limit line.
   - Accept the Limit line as it is set by clicking the Process icon on the Standard toolbar.

   Whether you add an item, change one, or accept the limit line as is, a Limit dialog box appears and prompts you to set a limit for that particular item or for the items with variable limits.

     Three items to focus on in the Limit dialog box are item, logical operator, and values.

![Limit dialog box diagram]

Three items to focus on in the Limit dialog box are item, logical operator, and values.
• **Items** are analogous to column fields in a database table. Examples of items include Org, Fund, and Transaction Type. The item you are limiting appears in the title bar.

• A **logical operator** defines the relationship between the values of a particular item. For instance, if you want to see all the data for org code 12300, you would select the operator “Equal.” If you want to see data for org codes 12300 through 12305, you would select “Between.”

A table of logical operators and how they function is on page 73.

• **Values** are the data of a particular item. For instance, for Business Unit, the values are 1 and J. For Accounting Period, the values are 0 to 12. Items with a small number of possible values have a list to make data entry easier. Other items have no values listed, and you must add them.

• Some items have “keys” at the top of the Limit dialog box, which translate database values into everyday language. For example, the Accounting Period limit translates period numbers into months (i.e., 1 = July, 2 = August, etc.).

3. Configure the Limit dialog box.
   
   a. Choose a logical operator from the pulldown list or accept the default.

   1. Click the down arrow.

   A list of logical operators appears.

   ![Logical Operators List](image)

   2. Click the logical operator you want from the list.

   3. Use the scrollbar, if necessary, to view more logical operators.

   A table of logical operators and how the function is on page 73.
### Logical Operators in the Limit Dialog Box

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>= Equal</strong></td>
<td>Returns data containing the highlighted values. For example, if orgs 12300 and 12310 are highlighted, the query returns data for these orgs only.</td>
</tr>
<tr>
<td><strong>&lt; &gt; Not Equal</strong></td>
<td>Returns data that does not contain the highlighted values. For example, if org 12300 and 12310 are highlighted, the query returns data for the other orgs that you are authorized to see.</td>
</tr>
<tr>
<td><strong>&lt; Less Than</strong></td>
<td>Returns data that is less than the highlighted value. If accounting period 5 is highlighted, the query returns data for accounting periods 0 - 4.</td>
</tr>
<tr>
<td><strong>&lt;= Less or Equal</strong></td>
<td>Returns data that is less than or equal to the highlighted value. For example, if accounting period 5 is highlighted, the query returns data for accounting periods 0 - 5.</td>
</tr>
<tr>
<td><strong>&gt; Greater Than</strong></td>
<td>Returns data that is greater than the highlighted value. For example, if accounting period 5 is highlighted, the query returns data for accounting periods 6 - 12.</td>
</tr>
<tr>
<td><strong>&gt;= Greater or Equal</strong></td>
<td>Returns data that is greater than or equal to the highlighted value. For example, if accounting period 5 is highlighted, the query returns data for accounting periods 5 - 12.</td>
</tr>
<tr>
<td><strong>Begins With</strong></td>
<td>Returns data that begins with the highlighted value. For example, when selecting account, if the value 5 is highlighted, the query returns all accounts that begin with the number 5.</td>
</tr>
<tr>
<td><strong>Contains</strong></td>
<td>Returns data that contains the highlighted value. For example, if the field is job code and the value Analyst is highlighted, the query returns all job codes that contain Analyst in them such as Sr. Analyst and Analyst.</td>
</tr>
<tr>
<td><strong>Ends With</strong></td>
<td>Returns data that ends with the highlighted value. If the field is vendor and the value Depot is highlighted, the query will return all vendors that end with Depot such as Office Depot and Home Depot.</td>
</tr>
<tr>
<td><strong>Like</strong></td>
<td>Similar to Begins With, Contains, and Ends With. Use with percentage sign % as a wild card before and/or after the value. For example, %OFFICE, %OFFICE%, or OFFICE%.</td>
</tr>
<tr>
<td><strong>Between</strong></td>
<td>Returns data that is between two highlighted values. If orgs 12300 and 12310 are highlighted, the query will return data for orgs 12300 through 12310 inclusively.</td>
</tr>
<tr>
<td><strong>Is Null</strong></td>
<td>Returns data that contains no value in a field. However, blank flexfields and projects appear in the database with a space. Thus, to find blank flexfields or projects, set a limit Equal to a quotation mark, followed by a space, and another quotation mark (i.e., “ ”).</td>
</tr>
</tbody>
</table>
b. Select or add one or more values depending on the logical operator.

For example, for Accounting Period, if you select the logical operator “Between,” you would want to select two values such as 1 and 5 to obtain information on accounting periods 1 through 5. If you select “Equal” for Org Code, you would add every org code you wanted to report on.

**Highlighted values are the ones you will retrieve data for. Unhighlighted values will be ignored.**

You can select values that appear in the values box or add your own.

**Selecting values**

- To select one value, click on it.

- To select two or more adjacent values, click the first value and simultaneously press the Shift key and click the last value you want.

The picture below shows the values 23135, 23136, 23137, 23644, and 24000 selected.

- To select two or more non-adjacent values, click the first value and simultaneously press the Control key (Mac users: _________) and click the other value(s) you want until all the values are selected.
The Query Section

The picture below shows the values 23135, 23137, and 24000 selected.

- To select all values, click the Select All button.

Adding values

When a value you want does not appear in the values box, you must add it.

- To add a value, type the value in the Edit field and click the green check mark.

The picture below shows the value 23135 typed into the Edit field.

After you click the green check mark, the value moves to the values box. The value is highlighted, indicating that it is selected.

If you mistakenly type a value into the Edit field, you can use the Delete or Backspace keys on your keyboard or click the red X to delete the value from the Edit field.

- To add another value, type it in the Edit field and click the green check mark.

The next value you added will appear in the values box, and now it will be the only highlighted value.
Since only the last value you add appears highlighted in the values box, when you add two or more values, you need to select the values you want to report on. Refer to the preceding section, “Selecting values” on page 74.

c. Click OK when you are done setting the operator and selecting values.

d. To retrieve all values for an item, click the Ignore button.

The Ignore button tells Brio to disregard limits for that item when retrieving data. For instance, if you click the Ignore button for Org, Brio retrieves data for all orgs that match your other limits and your authority.

e. To cancel setting a limit, click the Cancel button.

The Cancel button cancels applying a limit to a particular item and, for prompted limits, cancels the query before processing.

4. Configure the dialog box as necessary for each limit prompt.

- If you accepted the Limit line as it was set and clicked the Process icon, you are prompted for two limits, and then the query begins processing.

- If you want to add more items to the Limit line, click and drag items from the metatopic to the Limit line and configure the Limit dialog box as necessary. When you are ready to process the query, go to step 5.

- If you want to change the settings of more pre-set items on the Limit line, double-click on those items and configure the Limit dialog box as necessary. When you are ready to process the query, go to step 5.

5. When you are done setting limits, click the Process icon on the Standard toolbar.

The query begins processing. A “Waiting for Server” message appears in the Status bar in the bottom right indicating that the query has begun processing. The process may take some time. Do not click the Process icon again.

If processing takes too long, you can cancel your query. See “Cancelling a Query” on page 37.

Once a query is processed, data is returned to the Results section and the pre-built reports are populated with data.
The Query Section

Limit Dialog Box Options For Pre-Populated Items on the Limit Line

When you set limits for items on the pre-populated Limit line, the Limit dialog box that appears generally has the options listed below. There are exceptions to this rule, such as Accounting Period in summary reports, which has a pre-set logical operator and so does not have the Not or Ignore options.

![Limit Dialog Box]

Description of Limit Dialog Box Options

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Reverses the effect of a logical operator. If the operator was Equal and Not was checked, the operator applied would be Not Equal.</td>
</tr>
<tr>
<td>2</td>
<td>Adds a value typed in the Edit field into the values box. Add values when they do not appear in the values box.</td>
</tr>
<tr>
<td>3</td>
<td>Deletes a value typed in the Edit field.</td>
</tr>
<tr>
<td>4</td>
<td>Selects all the values in the values box.</td>
</tr>
<tr>
<td>5</td>
<td>Removes highlighted values from the values box.</td>
</tr>
<tr>
<td>6</td>
<td>Applies the limit. Click OK when you are done choosing a logical operator and selecting value(s).</td>
</tr>
<tr>
<td>7</td>
<td>Cancels applying limits and, for prompted limits, cancels the query before processing begins.</td>
</tr>
<tr>
<td>8</td>
<td>Disregards a particular item when retrieving data. Click Ignore when you want to see all values for a particular item.</td>
</tr>
<tr>
<td>9</td>
<td>Opens Brio.Insight help. Click Help when you need help or want more information. Brio Help is excellent.</td>
</tr>
</tbody>
</table>
Limit Dialog Box Options For Items Added to the Limit Line

When you drag items from a topic to the Limit line, the Limit dialog box that appears has four more options in addition to those described on the previous page.

Description of Further Limit Dialog Box Options

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td><strong>ShowValues</strong></td>
<td>Queries the database to display all possible values for the selected item, such as all funds used at UC Berkeley. <strong>Do not click this button. The database may search millions of rows to retrieve values, which takes a very long time. Press Alt+End to cancel searching.</strong></td>
</tr>
<tr>
<td>11</td>
<td><strong>CustomValues</strong></td>
<td>Displays a list of values saved with the limit or read from a file. This feature enables you to select values from a pre-defined pool. You can create and save a custom list with each limit.</td>
</tr>
<tr>
<td>12</td>
<td><strong>Custom SQL</strong></td>
<td>Displays the Custom SQL dialog box for coding limits directly in SQL. For users familiar with SQL. For more information, click the Help button and, on the Search tab, search for Custom SQL.</td>
</tr>
<tr>
<td>13</td>
<td><strong>Advanced</strong></td>
<td>Displays Loaded Values Settings to load data from a file or database and displays option to create a subquery. For more information on subqueries, click the Help button and, in the Table of Contents, display Query and Creating a Subquery.</td>
</tr>
</tbody>
</table>
Set Limits: Complex Limits

You can apply more than one limit to a single item or create complex conditions dependent on more than one constraint, such as a query limited to salary and benefit accounts. You use the operators AND and OR along with parentheses to set up these conditions. For instance, taking the example above, we would want a query to return accounts 50000 through 51999 and accounts 53000 through 53999.

When creating a complex limit, be aware of the following:

- **AND** retrieves data that meets both conditions. For example, if you set a limit for fund 19900 AND org 12307, the query will return transactions or balances that contain both fund 19900 and org 12307.

- **OR** retrieves data that satisfies either of two conditions. For example, if you set a limit for fund 19900 OR org 12307, the query will return transactions or balances that contain everything that matches either item (assuming no other limits are set).

- In general, use **OR** for discontinuous ranges of like items. For example, to retrieve equipment BUDSUM accounts, set a limit between accounts 54100 through 54250 OR between accounts 55200 through 55399.

- Equations are solved left to right, with operators within parentheses evaluated first.

- **AND** is evaluated before **OR**.

- In general, use parentheses ( ) for operations involving both AND and OR operators, enclosing the OR items in parentheses.

Create a Complex Limit

1. Change limit settings of items on the Limit line, if necessary.

   In our example, we would click on Account Code and set the limit Between 50000 and 51999.

2. Drag one or more topic items to the Limit line and apply individual limits as necessary.

   In our example, we would drag the Account Code item from the DIM_COA topic to the Limit line and set the limit Between 53000 and 53999.

3. Click the small arrow on the Limit line.
The line displays the line control buttons, the parentheses, and the Var buttons.

4. To enclose items in parentheses, move items by dragging them until they are side-by-side.

The picture below shows Account Code and Account Code_2 side by side.

5. Switch the AND operator between these limits to OR by clicking on the operator.

6. Highlight the items by clicking the first one, then simultaneously pressing the Shift key on your keyboard and clicking the last item.

7. Click the parentheses ( ) button.

The items are enclosed in parentheses. The picture below shows the two Account Code items enclosed in parentheses with an OR operator between them. Thus, the query below will return both salary and benefits account codes that meet the other criteria.

Note: To remove parentheses, click one of the parentheses in the Limit line and click the parentheses ( ) button.
Set Limits: Variable Limits

Variable limits are those you are prompted to set upon clicking the Process icon. BAIRS reports have at least two variable limits on the pre-populated Limit line. One variable limit is for accounting period and the other is for org. If you want to be prompted to set limits on other items, such as fund or flexfield, you can set variable limits for these items as well. Setting variable limits can save you time if you habitually limit certain items but not always for the same values.

1. Click the small arrow at the left edge of the Limit line. The line displays the line control buttons, the parentheses and the Var buttons.

2. Click the item on the Limit line.

3. Click the Var button on the Limit line.

The item displays with a V(#) extension, indicating that it is a variable limit. If more than one variable is set, the extensions are V(1), V(2), V(3), etc. These numbers indicate the order in which you are prompted to set item limits (after clicking the Process icon).

When you click the Process icon, a Limit dialog box will appear, prompting you to limit this item as well as other items set as variable limits.
The Results Section

Once a query is processed, data is returned to the Results section. Data appears in a single table. Items from the Request line make up the column headings. A row appears for each database record.

Data in the Results section is used to create pivots, charts, and tables. As such, you can use the Results section, for example, to apply local limits, format the numbers, or add a computed item. The changes you make in the Results section will be reflected in any pivots, charts, or tables you create in that document.

Local Limits

After data is returned, you might like to see how it would look if you had limited it to a particular fund or flexfield. You can do so without having to rerun the query by applying a limit to the results set. This type of limit is called a local limit.

Since other sections, such as reports, are based on data in the Results section, local limits applied to the Results will apply to all other sections. You can always remove this limit to return the original data.
Add a Local Limit

1. If the Limit line is not displayed, click the word Limit in the Section Bar.

2. Drag the gray bar above the item you want to limit to the Limit line.

   *Or:* Double-click the column of the item you want to limit.

   The Limit dialog box appears.

3. Configure the Limit dialog box.

   For complete details and fuller instructions on how to configure the Limit dialog box, see page 72.

   a. Choose a logical operator from the pulldown list or accept the default.

   b. Select or add one or more values depending on the logical operator.

4. When values are highlighted in the values panel, click OK.
The limited item appears on the Limit line, and the dataset narrows accordingly. In the picture below, Fund appears in the Limit line, and the Status bar indicates the narrowed dataset of 794 rows in the Results section out of 1320 rows returned from the query.

5. To add more limits, repeat steps 2 - 4 as necessary.

Remove a Local Limit

1. Macintosh and Windows: Click the item in the Limit line and press the Delete key.

   Windows: Right-click on the item in the Limit line and select Remove from the speed menu.

   The item is removed from the Limit line, and the dataset expands accordingly.

Format Numbers

If you want to change the number formatting from “00” to “$00.00,” for example, change the format in the Results section to avoid formatting numbers for each pivot or chart you may create in that document.

1. Select column(s).

   • To select one column, click either the gray bar above the column or the column itself, not the blue header. The column should appear highlighted.
• To select adjacent columns, select one column, then press the Shift key and simultaneously click on the last column you want to format. All the columns should be highlighted.

• To select non-adjacent columns, select one column, then press the Control key and simultaneously click each column you want to format. All the columns should be highlighted.

The picture below shows the columns Tempbudg, Actuals, Encumbrances, and Pre-Encumbrances selected.


   Windows: Right-click and select Number from the speed menu.
A Properties dialog box appears.

3. In the Number tab, select a Category.

4. Select a Format.
   - To display credit amounts with parentheses, click Category **Custom**. In the Format edit box, type in the following:
     
     
     #,##0.00;(#,##0.00)

5. Click OK.

The selected columns appear with the format selected.

**Note**  
The pre-formatted reports for each query will not reflect number formatting changes to columns that are formatted differently in the pre-built report. That is, making format changes in the Results section can be over-ridden or re-formatted again in the other sections.
The picture below shows the columns reformatted to include a dollar sign and two decimals.

![Image of a spreadsheet with reformatted columns]

**Computed Items**

A computed item is a “virtual” column as opposed to a column physically stored in the database. When you add a computed item, you are creating an equation using existing items and adding a new column to the results set. This computed item is also added to the Catalog panes of reports, tables, pivots, and charts for you to use in those sections as well.

You can use computed items, for example, to add Tempbudg and Actuals to see your “working” or “cash” balance.

The following instructions are to introduce you to computed items and are not intended as a complete description of this powerful tool. For more information, click Help on the Brio menu bar and in the Table of Contents, select Calculated Items.
Add a Computed Item

1. From the Results menu, select Add Computed Item.

The Computed Item dialog box appears.

- The **Name** field is the name of the computed item you are adding. It will appear on the column head and in the Catalog pane.

- The **Functions** button allows you to utilize internal functions such as math (for example, return the absolute value), numeric (return the largest value in a column of numbers), and statistical (such as return the median of a column of numbers) in your equation.

- The **Reference** button opens a dialog box with all the items in your results set. These items are available for you to manipulate mathematically in the new column.

- The **Operator** buttons apply mathematical functions or logical operators to your equation.

  A table of computed item operators and how they function is on page 91.

2. Type over “Computed” in the Name field with the name you want. Do not use spaces, if you intend to use this item in yet another computed item. Use underscores instead.

   **Note** For more information, see the on-line Help.
3. Click the Reference button.

The Reference dialog box appears.

![Reference dialog box]

Notice the items in the Item box. These items are those in the results set and so are the ones you will use to build your equation.

4. Click on the item that will be the first item in your equation.

5. Click OK.

That item now appears in the Definition box.

6. Click the Operator button to insert the mathematical or logical operator you want.

7. Repeat steps 3 - 6 as necessary until you are done building your equation.

The picture below shows the Computed Item named Working_Balance will be Tempbudg added to Actuals.

![Computed Item dialog box]

8. Click OK.
A new column labeled Working_Balance appears as the last column in the results set. Working_Balance is a sum of the Tempbudg and Actuals amounts. In the picture below, Working_Balance was moved next to Actuals. If you now inserted a new pivot or opened one of the pre-built reports, you would find an item in the Catalog panes of these sections labeled Working_Balance.
## Computed Item Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Plus sign. Adds items.</td>
</tr>
<tr>
<td>-</td>
<td>Minus sign. Subtracts items.</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication sign. multiplies items. For example, the equation: Tempbudg * (-1), would reverse the signs of Tempbudg debits and credits.</td>
</tr>
<tr>
<td>/</td>
<td>Divisible sign. Divides items.</td>
</tr>
<tr>
<td>{</td>
<td>Open parentheses. Starts an enclosed equation. Items in parentheses are solved first.</td>
</tr>
<tr>
<td>}</td>
<td>Closed parentheses. Ends an enclosed equation. Items in parentheses are solved first.</td>
</tr>
<tr>
<td>==</td>
<td>Equal sign. Returns items or operands that are equal.</td>
</tr>
<tr>
<td>!=</td>
<td>Not Equal sign. Returns items or operands that are not equal.</td>
</tr>
<tr>
<td>and</td>
<td>AND operator. Similar to the AND operator used on the Limit line in the Query section. Use AND to connect two conditional expressions and retrieve records only if each expression is true.</td>
</tr>
<tr>
<td>or</td>
<td>OR operator. Similar to the OR operator used on the Limit line in the Query section. Use OR to specify a combination of expressions and retrieve records that include at least one of the expressions.</td>
</tr>
<tr>
<td>if</td>
<td>If statement. Executes a set of statements if a specified condition is true. The specified condition may be another statement and can include other nested if statements. Braces, {}, must enclose multiple statements. If the condition is false, another set of statements can be executed if the optional Else statement is included in the script. A sample if … else statement looks like this: if (condition) {statements1} else {statements2}</td>
</tr>
</tbody>
</table>

The following is an example of the **User_Desc** computed item (which uses an If Statement) in the Standard Detail Report.
Computed Item Operators

This statement tests the condition of the **Transaction_Type** field. If **Transaction_Type** is “PO”, then **User_Desc** is set to the value in “Po_Desc”. If **Transaction_Type** is “REQ”, then **User_Desc** is set to the value in “Req_Desc”. If **Transaction_Type** is not “PO” or “REQ”, then **User_Desc** is set to the value in “Voucher_Desc” (since there are only three types of AP/PO transactions: Purchase Order, Requisition, or Voucher).

```plaintext
if (Transaction_Type = = “PO”)  
{Po_Desc}  
else if (Transaction_Type = = “REQ”)  
{Req_Desc}  
else  
{Voucher_Desc}
```

Notice the condition is in parentheses (), and the braces {} enclose the statement that is executed. An If Statement must be algebraically correct with balanced opening and closing parenthesis and braces.

**else**

Else statement. Works in conjunction with the If statement. See above.

**mod**

Modulus operator. Returns the remainder of dividing var1 by var2. For example, 5 % 4 returns 1.

**>**

Greater Than sign. Returns items or operands that are greater than another item or operand.

**>=**

Greater Than or Equal To sign. Returns items or operands that are greater than or equal to another item or operand.

**<**

Less Than sign. Returns items or operands that are less than another item or operand.

**<=**

Less Than or Equal To sign. Returns items or operands that are less than or equal to another item or operand.

**not**

Not operator. Returns items except for the ones specified. Use when you want to exclude a few items.
Grouping Columns

This feature in the Results section allows you to create a new column by grouping existing columns in the dataset. For example, if you want the value “Q1” to represent data for Accounting Periods 1 through 3, you would create a group.

Grouping columns and computed items differ in a few ways. Use grouping columns for non-numeric data, such as Accounting Period or Fiscal Year. Grouping columns may need to be updated when you re-run your report in a later accounting period. Computed items, if created solely with formulas, do not need to be updated.

Add a grouping column

1. In the Results section, click the column you want to group.

   The column should appear highlighted.

2. From the Results menu, select Add Grouping Column.

   The Grouped Column dialog box appears.

   ![Grouped Column: Accounting Period](image)

   The column selected appears in the dialog box title bar as well as in the Column Name field. Thus, in the picture above, we selected the column Accounting Period, so “Accounting Period” appears in both the title bar as well as the Column Name field.
The items in the Available Values box in the bottom right are the values from the column selected. Since we selected Accounting Period and we ran our query for periods less than or equal to 9, the values that appear are 0 - 9.

3. Change the Column Name field, if necessary, by typing over the default.
   
   This name will appear on the column heading and as the item name in the Catalog pane of other sections.

4. Click the New Group button.
   
   The New Group dialog box appears.

5. Enter the name of your first grouping.
   
   In our example, we would type “Q1” for Quarter 1.

6. Click OK.
   
   The new group appears in the Groups box at the left.

7. In the Available Values box, select the values you want in this group.
• To select one value, click on it.
• To select adjacent values, click on one and then simultaneously press the Shift key and click on the last value.
• To select non-adjacent values, click on one value and then simultaneously press the Ctrl key and click other values until all are selected.

8. Click the left pointing arrow to move highlighted values to the Items in Group box.

   The values move to the Items in Group box and are now the values that make up the group you have added.

9. Repeat steps 4 - 8 until you are finished creating all the groups for this column.

   In our example, we would also add the two groups “Q2” and “Q3,” adding accounting periods 3, 4, and 5 to Q2 and accounting periods 7, 8, and 9 to Q3. When finished, our dialog box would look like the one below.

10. When you are done adding groups, click OK.

    A new column appears with your rows grouped accordingly.
The picture below shows a new column “Quarters” with the values Q1, Q2, Q3, and blanks. Quarters was dragged next to Accounting Period to depict the relationship between these columns.

Quarters also becomes an item in the Catalog panes of the Pivot, Chart, and Report sections and may be used in those sections.

The picture below shows a Pivot report with Quarters and Accounting Period to further illustrate the relationship between the Grouping Column (e.g., Quarters) and the column grouped (e.g., Accounting Period).
The Report Section

This section covers how to modify and format the pre-built reports that come with all BAIRS reports. To be able to modify BAIRS reports, you first need to understand the elements that make up these reports.

Note: Before you modify a report, duplicate it first in case you make a mistake. For information on how to duplicate a report, see “Duplicate a Section” on page 55.

The Report Outliner

The structure of the report, which determines what information is displayed as well as the subtotalling and sorting options, is built by the outliner. The Report outliner has three panels, Report Groups, Table Dimensions, and Table Facts. The Report Group panel is further subdivided into Groups 1, 2, 3, etc. Generally, BAIRS reports are built with Groups 1 and 2.

Items in Report Group 1 generally

• correspond to the first item in the sort order.
• make up the main sort or “focus.”
• have a grand total.
• are made up of chartstring information.

Items in Report Group 2 generally

• create subgroups within Group 1.
• provide the full grouping for the table.
• are made up of chartstring information.
The picture below shows a report sorted by Fund, Org, Flex, Project, and Program. Notice that Fund is in Report Group 1 in the outliner, and Org, Flex, Project, and Program are in Group 2. Thus, this report groups first by fund and then within fund groups org, flex, project, and program. This allows for a table to be displayed and subtotalled for each unique combination of org, flex, project, and program within each fund. It also allows the report to sort and grand total by fund.

Items in the Table Dimensions:

- are non-quantifiable items, such as Transaction Type or Account Code.
- make up the text columns on the left side of the report.
- summarize the facts items.

In the picture above, Account Level 4 Node and Account Level 4 Description appear in the Table Dimensions outliner and along the left side of the report body. The account codes summarize the facts items, Tempbudg, Actuals, Encumbrances, Pre-Encumbrances, and Balance.
Items in the Table Facts:

- are quantifiable items, such as Tempbudg and Actuals Amounts.
- are values used in calculations, including subtotals and grand totals.
- appear in columns to the right of the Table Dimension column(s).

In the previous picture, the Facts items are Tempbudg, Actuals, Encumbrance, PreEncumbrance, and Balance, which appear to the right of the Account Level 4 Description. These facts are added to make up the subtotals and grand totals.

**Report Modification**

The table below describes modifications you might apply to BAIRS reports.

<table>
<thead>
<tr>
<th>Modification</th>
<th>How to Apply</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a report group, table dimension, or table fact</td>
<td>Click on the item in the Catalog pane and drag it to the appropriate outliner pane.</td>
</tr>
</tbody>
</table>
| Remove a report group, table dimension, or table fact | *Macintosh and Windows:* Click on the item in the outliner and hit the Delete key on your keyboard.  
*Windows:* Right-click on the item in the outliner and select Remove. |
| Change layout of report groups, table dimensions, or table facts | Drag report group and table dimension items to new positions within one outliner or across these outliner panels.  
*Or:* Drag items to new positions within the Table Facts panel.  
*Or:* Click on the table dimensions and table facts columns in the report body and drag them to new locations. |
<p>| Resize a column in the report body                | Click on a column in the report body. Position cursor over the column’s right margin. Your cursor becomes a double-arrow. Then double-click to Auto-size or drag the margin left or right. |</p>
<table>
<thead>
<tr>
<th>Resize a row in the report body</th>
<th>Highlight the row by clicking the top left-most edge of the row. Position the cursor over the bottom row margin. Your cursor becomes a double-arrow. Drag the margin up or down. All rows in the table are resized.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resize a report group header or footer</td>
<td>Click in a report group header in the report body. Position the cursor over the row’s margin, then double-click to Auto-Size or drag the margin up or down.</td>
</tr>
</tbody>
</table>
| Change font type, style, size or colors of text labels, headers, footers, or columns | **Macintosh and Windows:** Select the element (e.g., label, header, column). From the Format menu, select Font. Change font properties on the Font tab. All like labels, headers, and footers change. All columns change.  
**Windows:** Select the element (e.g., label, header, column), right-click, and select Properties or Font (for columns). Change font properties on the Font tab. All like labels, headers, and footers change. All columns change. |
| Change text label names | Select the element. Open the Expression line. Type over the name in the Expression line, but leave the quotation marks. For example, change the words “by Fund, Org, Proj, Flex” to “by Proj, Fund, Org”, but leave the quotation marks. |
| Change the number format | **Macintosh and Windows:** Select the column. From the Format menu, select Number. Change the number properties on the Number tab.  
**Windows:** Select the column, right-click, and select Number. Change the number properties on the Number tab. |

**Note**  
The modifications described above are not exhaustive. Once you are comfortable selecting elements and making some modifications, explore further by selecting elements and using the Format menu, the Report menu, the Formatting toolbar, and right-click (PC Users) or alt/option-click (MAC Users) speed menu options.
Headers and Footers

The information reflected in any header or footer corresponds to its place in the report structure. Accordingly, data displayed in a header for Report Group 1 will differ from that in a header for Report Group 2. In addition to headers and footers for each report group, reports can have page headers and footers as well.

The Page Header contains information such as the report name, the sort order, the selection criteria, the run date, the run time, and page numbers. Many of these items are field items and can be found in the Catalog pane in the Fields folder. The information in the Page Header is true for the whole report and repeats on each page.

The report group headers generally represent a unique combination of the chartfields by which this report is grouped. The picture below shows a Report Group 2 header. The first item, Fund 19900, is the Group 1 item, and the other items are Group 2 items. The box around the header and the resize handles appear when you click on this header.

The report group footers generally contain subtotals of facts columns for the group. The Report Group 2 Footer displays the subtotals for each unique combination of items in Group 2. The picture below shows a Report Group 2 Footer.

The Report Group 1 Footer displays subtotals for the item in Group 1. The picture below shows a Report Group 1 Footer.

Modify a Report Header

After modifying a report layout or sort using the outliners, you might want to edit the expressions in the headers to reflect the changes you have made. For example, you might change the Actuals to Tempbudg Report to sort by project and not group by flex.
In the outliner, you have removed flexfield from Group 1, added project to Group 1, and removed project from Group 2, but your header still begins with flexfield and has project in the wrong location. It still looks like the picture below.

1. Click on the header you want to edit.
   
   A gray box appears around the header.

   **Note** If you modify one header, all like headers change. Thus, if you modify one Report Group 2 header, all the Report Group 2 headers change.

2. If the Expression command line is not displayed, click Expression in the Section Bar.

   The Expression line displays. This line controls content information.

3. Resize the Expression line by double-clicking the vertical line on the left edge and dragging the bottom edge of the box down until you see the full expression.

4. To delete an item
   
   a. Highlight all the information pertaining to that item, including the final plus + sign.
b. Press the Delete key on your keyboard.

The picture below shows all the information pertaining to flexfield, including the final plus +, highlighted.

```
[Expression]
```

After clicking Delete, the highlighted information disappears and a red X and a green check mark appear on the Expression line.

![Expression with red X and green check mark]


c. To apply changes to the report, click the green checkmark.

d. To cancel the changes, click the red X.

e. Repeat steps a-d as necessary.

**Note**

If you are going to add or move information to a new location, do not delete the information you are replacing or moving. Keep the information you want to replace and type over it or cut and paste the information as in step 5 below.

5. To move an item to a new location

   a. Highlight all the information pertaining to that item, including the final plus + sign.
The picture below shows the information pertaining to project, including the final plus +, highlighted. We select project because, in this example, we moved project to Group 1, and we want project information at the beginning of the header to reflect the new sort order.

b. From the Edit menu, select Cut.

The highlighted information disappears from the Expression line.

c. Put your cursor in the desired location for the deleted information.

In our example, we place this information at the beginning of the expression.

d. From the Edit menu, select Paste.

The information appears in its new location.

e. Make any necessary formatting changes.

In the picture above, notice the pipe | that appears before the word Project in the very first line. This pipe acts as a separator on the header, but we do not need it at the very beginning of the header, so we delete it by highlighting it and pressing the Delete key.

f. To apply changes to the report, click the green checkmark.

g. To cancel the changes, click the red X.
The Report Section

h. Repeat steps a - g as necessary.

When you are done, your header reflects the changes made. The picture below shows project in the first position and flexfield removed. All the Report Group 2 headers in the report reflect this change.

Modify a Report Footer

When you first move items into Group 1, for instance, the information appears in the Report Group 1 header but not the footer. BAIRS reports display Group 1 items in the footer along with grand total information. Continuing with the previous example, we now want to hide project in the header, display it in the footer, and add totals in the footer for our facts items (e.g., TempBudg, Actuals, etc.).

1. To hide a Group 1 item in the header
   a. Click on the Group 1 item in the outliner.
      
      Windows: Right-click and select Header.
      
      Header is now de-selected.
      
      Windows: Right-click and select Footer.
      
      Footer is now selected, but the item does not yet appear in the Report Group 1 Footer.

2. To add a Group 1 item to the footer
   a. Scroll to any part of the report where the Group 1 item changes. That is, if the Group 1 item is Fund, scroll to where the report changes from 19900, for example, to the next fund number, 21270, for example.
The picture below shows the final subtotal for Project FPTRNG and the first head for Project FPHRMS.

b. Click in the blank space just above the second Report Group 2 header. See picture above.

A gray box appears around the Report Group 1 footer.

c. Drag the Group 1 item from the Catalog pane to the footer.

In our example, we would drag the item Real_Proj into the footer. Real_Proj will add the word “Blank” in the column for blank project codes, whereas the item Proj will add a blank space in the column for blank project codes.

d. Drag the facts items from the Catalog pane to the footer and place these items under the appropriate column.

The grand total appears for each column.

In our example, we are using the Actuals to Tempbudg Report, so we would drag the items Tempbudg, Actuals, Encumbrance, Pre-Encumbrance, and Balance.

e. Change the font formatting, if necessary.

Sort a Report

Sorting is distinct from groups and table dimensions. Once you set up the tables and groups, you can apply sorts to each element.
Sort Group Headers

1. If the Sort line is not displayed, click Sort on the Section Bar.

2. Click on a Report Group header in the report.

3. Do one or all of the following:
   - If the Sort line is pre-populated, click on the item in the Sort line that you want to sort by.
   - If the Sort line is pre-populated, but does not have the item you want, click on the item in the report (not the outliner) and drag it to the Sort line.
   - If the Sort line is blank, drag the header from the report (not the outliner) to the Sort line.

4. Click the Ascending or Descending icon on the Standard toolbar, if necessary.
   The report changes accordingly.

Sort Table Dimensions

1. If the Sort line is not displayed, click Sort on the Section Bar.

2. Click on the column in the report body.
   The default sort order appears in the Sort line.

3. To remove the default sort order, click on it in the Sort line and press the Delete key on your keyboard.
   The default sort order is removed from the Sort line, and the report changes accordingly.

4. Drag the column you want to sort by to the Sort line.
   The item that corresponds to that column appears in the Sort line.

5. Click the Ascending or Descending icon on the Standard toolbar.
   The report changes accordingly.
Page Breaks

Generally, pages break at each change in a Group 1 item. Thus, if Fund was in Group 1, and you had for example, 19900, 20270, 56190, and so on, the page would break after totals for 19900, after totals for 20270, and after totals for 56190. You can insert or remove page breaks before or after a report body or a report group label.

Insert a Page Break

1. Select a report group header.

2. From the Insert menu, select Page Break After or Page Break Before.

   A page break is inserted.

Remove a Page Break

1. Select a report group header.

2. From the Insert menu, select the checkmarked Page Break After or Page Break Before.

   The page break is removed.
The Pivot Section

Pivot reports are a powerful analytical tool for grouping, focusing, subtotalling, and organizing your financial data in practically any way that might be meaningful for your department. Pivots are particularly useful for answering ad-hoc questions.

Pivots resemble spreadsheets or crosstab reports. They have side labels, top labels, and facts. The side labels form the rows of your pivot, and the top labels form the columns. The side and top labels can consist of items such as org, fund, fiscal year, or flex. Facts represent the values displayed. They are quantifiable figures or dollar amount items such as balance, actuals, or encumbrances.

Data in a Pivot

A pivot is made up of data in the Results section. If you process a query and limit your results to only supply and equipment accounts, your pivot will reflect this limit as well. If you want a pivot that reflects only two funds, limit your query for those two funds. If you add a computed item in the Results section, the computed item will appear as one of the request items in the Catalog pane for the pivot, and you can use it in your pivot.

Create a Pivot

1. From the Insert menu, select New Pivot.
A new section called Pivot appears in the Section pane. The Catalog pane displays request items. The Pivot outliner appears at the bottom of the screen, and the Document section is blank.

2. If the outliner is not displayed, click Outliner on the Section Bar.

The Pivot Outliner has three panels, Side Labels, Top Labels and Facts.

3. Click on a request item in the Catalog pane.

4. Drag the request item to the side, top or facts outliner.

Be aware of the following:

- Side Labels form rows; Top Labels form columns; Facts show values.
- You can add multiple items to any outliner. For instance, you can put both org and fund into Side Labels.
- Items are ordered hierarchically in the sequence in which they appear in the outliner panels. Thus, if your Side or Top Label has fund followed by flexfield, the fund(s) will appear and then the flexfields within that fund.
The Pivot Section

- Side and Top Labels consist of “text” items (e.g., fund, org, org description) or date items (e.g., fiscal year, accounting period).
- Facts consist of figure items (e.g., balance, tempbudg amount).
- Facts are summed by default.

5. Repeat steps 3 - 4 until you are done with the report.

The example below illustrates how you might look at projects within funds across orgs. The pivot shows Fund and Project in the Side Labels, Org and Org Description in the Top Labels, and Tempbudg and Actuals amounts in the Facts.

6. To remove an item from one of the labels
   - *Macintosh and Windows:* Click on the item in the outliner and press the Delete key.
   - *Windows:* Right-click on the item in the outliner and select Remove from the speed menu.

7. To rearrange the order of items in a label, click on items in the outliner and drag them until they are in the order you want. The pivot report changes accordingly.
Pivot a Report

If you decide you want to move top labels to the side or side labels to the top, you can quickly rearrange your data by dragging the side or top label handles.

1. Click the handle of the label you want to move.
2. Drag this handle to a new location.

The picture below shows fund code being dragged from the side to the top.
The item moves to its new location and your pivot changes accordingly. The picture below shows fund code in the top label.

![Pivot Section](image)

**Add Totals to a Pivot**

You can add grand totals and subtotals easily to pivot reports.

1. To add a total, select a label handle.
   - For grand totals click the “outside” side or top handle of the column or row that you want to grand total.
   - For subtotals, click one of the “inside” side or top handles of the column or row that you want to subtotal.

2. *Macintosh and Windows:* From the Pivot menu, select Add Totals.

   *Windows:* Right-click and select Add Totals from the speed menu.

   Grand totals appear at the very bottom of the pivot or to the far right. Subtotals appear at the bottom of the selected side label or to the right of the selected top label.
In the picture below, the handle for fund was selected, and thus, the grand totals added are for the Tempbudg and Actuals amounts for each org.

In the picture below, the handle for project was selected, and thus, the subtotals added are of Tempbudg and Actuals amounts for each fund.
Sort Data in a Pivot

You may want your fund numbers in descending rather than ascending order or you may want your balances to appear in order of highest to lowest. You can sort labels using the Ascending or Descending icons on the Standard toolbar, and you can sort facts columns using the Sort line. Instructions for each procedure follow.

Sort Labels

1. Click the handle of the label you want to sort.
   
   The entire label highlights.

2. Click either the Ascending or Descending sort icon on the standard toolbar.

   ![Ascending or Descending sort icon]

   The items appear sorted in order selected.

Sort Facts Columns

1. If the Sort line is not displayed, click Sort in the Section Bar.

   ![Sort line]

   2. Select a label to sort from using the first pulldown menu.

   ![First pulldown menu]

   In the picture above, notice that the labels you have to choose from are those that appear in the side and top outliners.
3. In the “by” pulldown menu, select Label to sort labels alphabetically or incrementally or select a fact item to sort by.

4. If sorting by a fact item, select a data function in the “using” pulldown menu. The “using” pulldown menu is not available when sorting by Label.

5. Click either the Ascending or Descending sort icon in the Sort line.
The report sorts accordingly. The picture below shows the pivot report sorting Project by Working Balance using Sum in descending order.

Spotlight Information

If you want to highlight exceptional figures, you can use the spotlight feature. When you use the spotlight, you apply color and font changes to figures that are, for instance, greater than, equal to, or less than a value you set. In our example, we will highlight all figures over 1,000,000.

Note  Information can be spotlighted on reports, tables, and results as well. Use the instructions below for these other sections.

Add a Spotlight

1. Select one or more fact columns in the pivot by clicking on the column. Column should appear highlighted.

2. From the Format menu, select Spotlighter.
The Spotlighter dialog box appears.

3. Choose a comparison operator from the pull-down menu.

   The comparison operators available are equal =, not including < >, less than <, less than or equal to ≤, greater than >, and greater than or equal to ≥. In our example, we would choose the greater than symbol, >.

4. In the Value field, enter a value.

   In our example, we would type “1,000,000.”

5. Choose a text style, background color fill, and text color.

   The Sample box displays your formatting changes before you apply them so you can experiment with them. In our example, we chose bold text with a red background fill.

6. Click the green check mark.
The value moves from the Value field to the scrollbox on the Spotlighter, and the spotlighter is applied to the selected Fact column in the pivot.

Modify a Spotlight

1. Select the spotlighted fact column(s) in the pivot.

2. From the Format menu, select Spotlighter.

   The Spotlighter dialog box appears. The spotlighter formats applied to this fact column appear in the scrollbox.

3. Double-click on the format to modify in the scrollbox.

   The operator, value, and text formats become available for you to edit.

4. Make formatting changes, including changing the operator, the value, or the text style or color.
5. Click the green check mark to apply the modified spotlighter format.
   
The spotlighter is modified for the selected fact column(s).

Remove a Spotlight

1. Select the spotlighted fact column(s) in the pivot.

2. From the Format menu, select Spotlighter.
   
The Spotlighter dialog box appears. The spotlighter formats applied to this fact column appear in the scrollbox.

3. Click on the format to remove in the scrollbox.
   
   This step is essential. If you do not click on the format, you might remove the fact column instead.

4. Click the Remove icon on the Standard toolbar.

   The spotlighter is removed from the selected Fact column.

Drill Anywhere

If you want to see more detail behind a particular label on a pivot, you can get to that data using the Drill Anywhere feature. For example, you might have a pivot with funds and flexfields across orgs, but you want to see the accounts associated with one or two flexfields. You can get to this detail with the Drill Anywhere feature.

In our example, we look at a pivot with project codes and from one of these project codes, we will drill into Account Level 4 Nodes.

1. Click on one or more label items from the same dimension to drill into (e.g., two project codes or three different fund codes).
   
   Clicking on one label item highlights all like label items.
In our example, we select FPTRNG. In the picture below, notice four project codes (including the blank) appear. We click on one FPTRNG label, which highlights all FPTRNG labels.

2. **Macintosh and Windows**: From the Pivot menu, select Drill Anywhere. **Windows**: Right-click and select Drill Anywhere from the speed menu. A list of items to drill into appears.
3. Click an item to drill into.

In our example, we would select Account Level 4 Node.

The selected labels are now broken down by the item you selected. Labels that were not selected are hidden. In the outliner, the drilled item is added to the appropriate panel, and a drill-bit icon appears before the drilled item.

In the picture below, Account Level 4 Nodes appear after FPTRNG, the item we drilled into. The other project codes are hidden, and a drill bit appears before Project in the Side Labels outliner, indicating that we have drilled into Project. Account Level4 Node is added to the Side Label panel in the outliner.

Drill Up

After you have used the Drill Anywhere feature, you might want to restore the pivot to its original state. You can do this using the Drill Up feature.

1. In the pivot report, click the label item that was added after drilling.

   Using our previous example, we would click any of the added Account Level 4 Node labels.

Windows: Right-click and select Drill Up from the speed menu.

The drilled into item disappears. Hidden labels reappear. In the Outliner, the drilled item is removed from the appropriate panel, and the drill-bit icon disappears.

Format a Pivot

Formatting a pivot involves two steps.

1. Select the label, column, or row you want to format.

The table below describes how to select pivot elements.

<table>
<thead>
<tr>
<th>Element</th>
<th>How to Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>labels</td>
<td>Click on the label. You select only one label, but all like labels are highlighted. For example, if you have projects within fund, and project FPBFSX is repeated several times, clicking on one FPBFSX label highlights all of them.</td>
</tr>
<tr>
<td>columns</td>
<td>Click on the column. All like fact columns highlight, but the top labels do not.</td>
</tr>
<tr>
<td>rows</td>
<td>Simultaneously press the Alt key and click on the label of the row. The entire row, including the corresponding side label(s), and all like rows highlight.</td>
</tr>
</tbody>
</table>

2. Make formatting changes.

- Macintosh and Windows: Use the Format toolbar and/or the Format or Pivot menus to modify the element.
- Windows: Right-click on the element and select an option from the speed menu.
The table below describes some formatting changes you can apply to pivot elements.

<table>
<thead>
<tr>
<th>Format</th>
<th>How to Apply</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change background fill</td>
<td>Use Fill Color icon on the Formatting toolbar.</td>
</tr>
<tr>
<td>Change borders</td>
<td>Macintosh and Windows: From the Format menu, select Borders, then type of border (e.g., None, Horizontal, 3-D Raise). Windows: Right-click, select Borders, then type of border (e.g., None, Horizontal, 3-D Raise).</td>
</tr>
<tr>
<td>Change label name</td>
<td>Double-click on the label and type a new name in the Set Label Item dialog box.</td>
</tr>
<tr>
<td>Change the number format of fact items</td>
<td>Macintosh and Windows: From the Format menu, select Number. Change number properties on the Number tab. Windows: Right-click and select Number. Change number properties on the Number tab.</td>
</tr>
<tr>
<td>Resize a column</td>
<td>Position cursor over the column’s margin, then double-click to Auto-size or drag the margin left or right. All like columns are resized.</td>
</tr>
<tr>
<td>Resize a row</td>
<td>Position the cursor over the bottom row margin, then double-click to Auto-size or drag the margin up or down. All like label rows are resized.</td>
</tr>
</tbody>
</table>

**Note** The formatting possibilities described in the table above are not exhaustive. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the Pivot menu, the Format menu, the Formatting toolbar, and right-click (PC Users) or alt/option-click (MAC users) speed menu options.
The Chart Section

You can present data visually by creating a chart. Charts can demonstrate with a picture how much money you have spent on staff salaries and staff benefits, for instance, or indicate spending of funds across accounting periods, or visually represent missing flexfields in transactions across orgs.

The types of charts available include bar, stacked bar, cluster bar, line, bar-line, area, stacked area, ribbon, and pie. For more information about these individual types, turn to “Select a Chart Type” on page 130.

Data in a Chart

A chart is made up of data in the Results section. If you process a query and limit your results to only supply and equipment accounts, your chart will reflect this limit as well. If you want a chart that reflects only two funds, limit your query for those two funds. If you add a computed item in the Results section, the computed item will appear as one of the request items in the Catalog pane for the chart, and you can use it in your chart.

Create a Chart

1. After you process the query, from the Insert menu, click New Chart.
A new section called Chart appears in the Section pane. The Catalog pane displays request items. The chart outliner appears at the bottom of the Contents pane, and the Document section is blank.

2. If the outliner is not displayed, click Outliner on the Section Bar.

   The chart outliner has three panels, Y-Facts, Z-Categories, and X-Categories.

3. Click on a request item in the Catalog pane.

4. Drag the request item to the Y-Facts, Z- or X-Category outliner.

Be aware of the following:

- **Y-Facts**
  - Consist of quantifiable figure items (e.g., balance, tempbudg amount).
  - Make up the graphical elements (e.g., bars, lines) in the chart.
  - Make up the y-axis, which runs vertically on all charts, except horizontal and pie charts. On horizontal charts, the y-axis runs vertically, and on pie charts the items placed in Y-Facts, make up the pie.
• Are summed by default, but this can be changed.

• Z- and X-Categories
  • Consist of non-quantifiable items, such as “text” items (e.g., fund, org, org description) or date items (e.g., fiscal year, accounting period).
  • “Divide” or “split” the Y-Facts by the items placed in these outliners.

• Z-Categories
  • Make up the z-axis, which often runs back or “into” the chart, creating a 3-dimensional feel to most charts.
  • Are not available for pie charts.

• X-Categories
  • Make up the x-axis, which runs horizontally on all charts, except horizontal and pie charts. On horizontal charts, the x-axis runs vertically, and on pie charts the items placed in X-Categories make up the slices of the pie.
  • You can add multiple items to any outliner.
  • Items are ordered hierarchically in the sequence in which they appear in the Outliner panels. Thus, if you have org followed by fund, the org(s) appear first and repeat for each matching fund.

5. Repeat steps 3 - 4 until you are done with the report.

6. For bar charts, change what the colors represent, if necessary, by clicking the Legend On icon on the Section toolbar and selecting a different legend.

The colors and legend change according to the axis selected.
The picture below shows a vertical bar chart of salary account balances. Note that the query was limited to only salary accounts. The legend is set to “Legend on X,” and the legend depicts account codes, which is the item in the X-Categories outliner. If the legend was set to “Legend on Z,” all the bars in the picture below would be the same color since there is only one Fiscal Year.

7. To remove an item from one of the outliners

   - *Macintosh and Windows:* Click on the item in the outliner and press the Delete key.
   - *Windows:* Right-click on the item in the outliner and select Remove from the speed menu.

   The chart changes accordingly.

8. To rearrange the order of items in an outliner, click and drag items until they are in the order you want. The chart changes accordingly.

9. To move items between outliners, click and drag items from one outliner to another. The chart changes accordingly.
Change the Chart Type

The default chart is a vertical bar chart. You can change this chart type at any time.

1. To display chart types, select one of the following options:
   - From the Format menu, select Chart Type and then the type of chart.
   - If the Section toolbar is not displayed, display it by selecting the View menu, then Toolbars and Section. Click the Chart Type icon on the Section toolbar and select another chart type.

   ![Chart Type Options]

   The chart changes accordingly.

2. If you have items in Z-Categories and you are selecting a pie chart, you will get a message asking whether you want to move Z-Categories items to the X-Categories or to remove the Z-Category items altogether.

   ![Message]

   - Click Move to move items from the Z-Categories to the X-Categories.
   - Click Remove to remove the Z-Categories items from the chart.
   - Click Cancel to leave the chart the way it is.
Select a Chart Type

Different charts offer different ways to visually present data. Some charts are more meaningful than others for a particular set of data. Below are descriptions of some chart types, how you might use them, and examples of these charts.

Bar Charts

Bar charts can be either vertical or horizontal. Y-Facts items determine the height of each bar. Items placed in the X-Categories create one set of bars along the x-axis. Placing items in the Z-Categories creates a 3-dimensional look with bars behind each other along the z-axis.

The chart below is a horizontal bar chart depicting accounting periods across actuals.
Vertical Cluster Bar Charts

This chart represents items in clusters side-by-side. When this chart type is selected, the Z-Categories outliner changes to Z-Cluster. Items placed in the Z-Cluster outliner will determine what clusters together across the X-axis. Place items you want to compare in Z-Cluster. Place the item you want to compare “across” in X-Categories. The legend should be on Z to differentiate items in the clusters.

The picture below shows actuals clustered by funds across accounting periods. The legend is on Z, funds.
Pie Charts

This chart represents items in a pie shaped graphic. The Y-facts make up the entire pie, which is divided into “slices” by items placed in the X-Categories outliner. Since pie charts are two-dimensional, Z-Categories are not available.

The picture below shows a pie chart of actuals amounts per fund. Notice that some of the funds are such a small percentage of the pie that, though they appear in the legend, they either do not appear in the pie or are very difficult to see.
Stacked Bar Charts

Stacked bar charts can be either vertical or horizontal and offer a similar complexity as cluster bar charts. Stacked charts are useful for comparing across sums of several indicators. When this chart type is selected, the Z-Categories outliner changes to Z-Stack. Items placed in the Z-Stack outliner stack on top of each other across the X-axis. The legend should be on Z to differentiate pieces of the stack.

The picture below shows a vertical stacked bar of actuals for funds across accounting periods 0 through 7. The legend is on Z.
Line Charts

Line charts can be thought of as dots connecting the tops of a bar chart. These charts are effective for showing highs and lows in a continuum. Items placed in the Y-Facts determine the position of the dots. Items placed in the X-Categories will create one line. Place items in the Z-Categories to create multiple lines.

The picture below shows Actuals across accounting periods for two orgs. The legend is on Z.
Bar-Line Charts

Bar-line charts are useful for comparing multiple facts items in one chart. The first item placed in the Y-Facts determines the height of the bars. The second item placed in the Y-Facts determines the position of the dots on the line. X-Categories itemize the bars and line markers. You can make this chart 3-dimensional as well, but clarity is reduced as items are added to the Z-Categories.

The picture below shows a bar-line chart comparing actuals (the bars) to tempbudg amounts (the line) across funds. Notice the user created a computed column that reversed the sign of the TempBudg column, making it a positive number so that it would be easier to compare actuals to tempbudg amounts.
**Area Charts**

Area charts are similar to line charts, but with the area under the line filled in. Items placed in the Y-Facts determine the “tops” of the area. Items placed in the X-Categories create one area segment. Place items in the Z-Categories to create multiple area segments.

The picture below shows Actuals across accounting periods for one org. This picture uses similar data as the line chart on page 134, only this chart focuses on one org instead of two.
Stacked Area Charts

Area charts can be stacked in the same way as bar charts. Items placed in the Y-Facts determine the “tops” of the area. Items placed in the X-Categories create the continuum you will compare across. When this chart type is selected, the Z-Categories outliner changes to Z-Stack. Items placed in the Z-Stack outliner stack on top of each other across the x-axis. The legend should be on Z to see the sum of items.

The picture below shows a stacked area chart of actuals for funds across accounting periods 0 through 7. The data is the same as the stacked bar chart on page 133.
Ribbon Charts

Ribbon charts are also similar to line charts, only the lines are 3-dimensional “ribbons.” Items placed in the Y-Facts determine the position of the line marker. Items placed in the X-Categories will create one ribbon. Place items in the Z-Categories to create multiple ribbons.

The picture below shows actuals across accounting periods for two orgs. The legend is on Z. This picture uses the same data as the line chart on page 134.

Modify Chart Properties

You can make charts bigger, rotate them, change the title, create a subtitle, change the scale, and modify many more properties. You can modify general chart properties using the Properties dialog box or select an element on the chart, such as a bar or axis value, and modify it.

Use the Properties Dialog Box

1. From the Chart menu, select Properties.
The properties dialog box opens

2. To modify general properties, click the General tab.

On the General tab, among other features, you can

- rename, hide or show the chart title or subtitle.
- hide or show the legend.
- rotate the chart.
- hide or show planes, which are the gray “backings” and “sidings” of most charts.
3. To modify the X- and Z-Categories labels, click the Labels Axis tab.

On the Labels Axis tab, among other features, you can

- rename, hide or show the axis labels.
- hide or show the tickmarks.
- change the frequency of the labels. Using this feature, you can skip axis labels. For instance, if you turned off the auto frequency of the x-axis and chose to show the labels at every “2” values, you would see 2, 4, 6 instead of 1, 2, 3, 4, 5, 6, 7.

4. To modify the left and right axis values, click the Values Axis tab.
On the Values Axis tab, among other features, you can

- rename, hide or show the left and right labels.
- hide or show values at intervals and on the right side.
- change the left axis scale. Using this feature, you can create more or fewer intervals along the left axis as well as increase or decrease minimum and maximum values along the left axis. For instance, if your scale had intervals every 1000 (dollars), if you changed the interval to 500 (dollars), you would see more intervals along the left axis.

5. To modify bar and bar-line charts, click the Bar Chart tab.

![Properties](image)

On the Bar Chart tab, among other features, you can

- hide or show values on the bars.
- hide or show values on the lines.
- move the points of the line of bar-line charts to the left or center of the bars.

Modify an Individual Chart Element

Modifying individual chart elements involves two steps.

1. Select the element.
The table below describes how to select individual chart elements.

<table>
<thead>
<tr>
<th>Element</th>
<th>How to Select</th>
</tr>
</thead>
<tbody>
<tr>
<td>bar, pie slice, line or area</td>
<td>Click on the element.</td>
</tr>
<tr>
<td>X- or Z-Category labels</td>
<td>Click on a label in the Contents pane. One label appears selected. However, all labels along the axis are affected.</td>
</tr>
<tr>
<td>left or right axis labels</td>
<td>Click directly on any axis value in the Contents pane. All the labels are highlighted and affected.</td>
</tr>
<tr>
<td>chart, to modify properties</td>
<td>Click on any axis.</td>
</tr>
<tr>
<td>chart, to resize</td>
<td>Click on the box around the chart.</td>
</tr>
<tr>
<td>titles, subtitles, legend, or text boxes</td>
<td>Click on the element.</td>
</tr>
</tbody>
</table>

2. Make formatting changes.
   - *Macintosh and Windows*: Use the Format toolbar and/or the Format or Chart menus to modify the element.
   - *Windows*: Right-click on the element and select an option from the speed menu.

The table below describes some formatting changes you can apply to individual chart elements.

<table>
<thead>
<tr>
<th>Format</th>
<th>How to Apply</th>
</tr>
</thead>
</table>
| Change colors of chart elements (bars, lines, or plane) or text items | *Macintosh and Windows*: Select the element. Then from the Formatting toolbar, use the Fill icon and Text color icons.  
*Windows*: Select the element, right-click, and select Properties. Change colors on the Patterns tab. |
### The Chart Section

| Change font of axis values or labels | **Macintosh and Windows:** Select the axis value or label. Then from the Format menu, select Justify, and the type of justification (e.g., left, middle, vertical rotated up, etc.).  
**Windows:** Select the axis value or label, right-click, select Justify, and the type of justification (e.g., left, middle, vertical rotated up, etc.). |
| Change the number format of axis values or labels | **Macintosh Windows:** Select the axis value. Then from the Format menu, select Number, and on the Number tab, select the formatting (e.g., percentage, currency, date, custom.)  
**Windows:** Select the axis value or label, right-click, select Number, and on the Number tab, select the formatting (e.g., percentage, currency, date, custom). |
| Justify axis values | **Macintosh and Windows:** Select the axis value. Then from the Format menu, select Justify, and the type of justification (e.g., left, middle, vertical rotated up, etc.).  
**Windows:** Select the axis value, right-click, select Justify, and the type of justification (e.g., left, middle, vertical rotated up, etc.). |
| Resize a chart | **Macintosh and Windows:** Select the box around the chart. Click a resize handle and drag. |
| Show grid lines | **Macintosh and Windows:** Select the chart. Then from the Format menu, select Grid Lines and Show Y-, X-, or Z-Axis Grid Lines.  
**Windows:** Select the chart, right-click, and select Show Y-, X-, or Z-Axis Grid Lines. |

**Note**
The formatting possibilities described above are not exhaustive. Brio has many formatting features per individual chart as well. Once you are comfortable selecting elements and making some formatting changes, explore further by selecting elements and using the Chart menu, the Format menu, the Formatting toolbar, and right-click (PC Users) or alt/option-click (MAC Users) speed menu options.
Save a “Super” Report

The process for saving “Super” reports to your desktop is identical to saving Basic reports as covered in the BAIRS Basics manual.

However, when saving “Super” reports, keep in mind the following:

• You do not need to save query results with your document since you can refresh the results by running the report from your desktop.

• All the pivots, charts, additional reports, and formatting changes you made to reports will be saved.

• Upon save, the report name defaults to the name of the report and the date the report was modified. You can type over this name.

• If you have a Pivot or Chart section in the document and you do not save results, the pivot and chart retain a “shadow” of previous results and appear with data. This preserves the structure of the pivot or chart. The Results and Report sections, however, are blank. When you process the query, the Results and Report sections populate with data, and the data in pivots and charts is refreshed.

• If you make additional formatting changes or add new sections to the Brio document on your desktop, remember to save again.

The process for opening “Super” reports is identical to opening Basic reports, as covered in the BAIRS Basics manual.
Run a “Super” Report From Your Desktop

The process for running a “Super” report from your desktop is the same as running a “Super” report on the portal. For step-by-step instructions, see “The Query Section” on page 68.

However, since you are not logged in to the Berkeley Reporting Portal when you process the query of a report saved to your desktop, you will be prompted for a username and password to login to the OnDemand Server and access the data.

Fill in the OnDemand Server Dialog Box

1. Type over the Username with your BAIRS User ID, if necessary.
   
   If someone emails a Brio document to you, their User ID will appear in this field, and you will need to replace it with yours.

2. Type your BAIRS password in the Password field.

3. Click OK. Note that you may be prompted for the variables limits a second time.

   The document connects to the server and the query begins processing.